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Introduction 
Congratulations on your purchase of UPSentry Smart 2000 Shutdown Management 
Software to manage your Uninterruptible Power Supply (UPS). The goal of UPSentry 
Smart 2000 is to monitor your UPS and take care of all your power management needs. 
UPSentry has the ability to properly shutdown your computer when an extended power 
outage occurs. 
UPSentry provides the most useful information about the UPS and all of your power 
management inquiries. We added the most popular network management 
protocol(SNMP) into UPSentry, UPSentry will translate UPS information into SNMP 
MIB to the appropriate Network Management Station(NMS) such as HP OpenView. To 
make use of resources on the Internet, UPSentry also supports HTTP protocol. That 
means you can monitor your UPS anywhere, anytime just using the Internet browser. 
UPSentry runs in the background as a daemon process on UNIX systems, and 
communicates to the UPS to keep your computer and equipment protected from any 
power problems. Furthermore, it gives you the most useful information about your UPS 
and computer. 
 
UPSentry Smart 2000 features: 
1.Graceful operating system shutdown  
2.Schedule test, shutdown/restart UPS, turn on/off receptacles  
3.Flexible events  
4.Notification: Pager, e-mail and audible alarm, network broadcasting and SNMP  
5.real-time values of voltage, current, frequency and loading...  
6.History data & graph  
7.Network monitor  
8.Multi-computer shutdown/restart  
9.Support Simple Network Management Protocol (SNMP)  
10.Support HTTP, remote monitor and control using Internet browser  
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UPSentry Smart 2000 Installation 
System Requirements: 
1. To use UPSentry Smart, your system must be running one of the following 

operating systems: 
 Hewlett Packard HP-UX 10.0 (UPSentry Service Only) 
 IBM AIX 4.3 
 SCO OpenServer 5.0 
 SunSoft Solaris 2.5.1 for SPARC processors 
 RedHat Linux 5.2, Turbo Linux 4.0, Suse Linux 6.1, Open Linux 2.3 
 FreeBSD 2.2.8 

2. UPSentry Monitor can run on X11R6 or above with 256 or more colors. 
 
UPSentry Smart 2000 Setup: 
1. To setup UPSentry Smart 2000, please login to your system as supervisor (root). 
2. Place the UPSentry Smart 2000 CD in your CD-ROM drive and mount it.  
3. Change the working directory to /CD-Rom/Unix/YourUnix, where /CD-Rom is the 

mount point of your CD-ROM drive, and YouUnix is the name of your Unix System. 
For example, /cdrom/Unix/Linux or /cdrom/Unix/Sun. 

4. Copy the only one file, YourUnix.tar,  in your working directory to directory /tmp. 
5. Change your working directory to /tmp. 
6. Tar the file with the command: tar xvf YourUnix.tar. Note that some OS may require 

“-“ before arguments. 
7. Run ./install. 
8. Follow the instructions from the install program. 
9. After installation, UPSentry Smart 2000 program files will be located in the directory 

/usr/local/smart. 
Notice: Some OS may not activate COM port as default. Thus, make sure the COM 
port connects to UPS has been activated before running UPSentry Smart 2000. 
The UPSentry Smart 2000 software is comprised of two modules: 

 A UPS Monitoring Module (UPSentry Service, file name: upsd), that runs in the 
background as a daemon process on your system and communicates to the UPS.  

 A User Interface Module (UPSentry Monitor, file name: monitor), that enables 
you to control and configure UPSentry through the drop down menus and dialog 
boxes. It also allows you to monitor the UPS through the Main Screen.  
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UPSentry Service 
UPSentry Service, which runs in the background, is a daemon process when the 
system starts up. You can also run UPSentry Service manually by typing the command 
/usr/local/smart/upsd.  To stop UPSentry Service, type the command 
/usr/local/smart/upsd stop. 
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UPSentry Monitor 
UPSentry Monitor enables you to control and configure UPSentry through the drop 
down menu and dialog boxes. It also allows you to monitor the UPS through the Main 
Screen. UPSentry Monitor does not need to reside in the memory, the execution 
depends on the user's requirement. This can save precious system resources for you. 

After finishing the UPSentry Smart 2000 installation, UPSentry Service automatic loads 
into memory and runs once the operating system starts up.  

To run the UPSentry Monitor, change your working directory to /usr/local/smart and 
type the command /usr/local/smart/monitor.  

UPSentry Monitor Main Screen: 
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Networking 
UPSentry Smart 2000 software is comprised of two modules: UPSentry Service and 
UPSentry Monitor. You may run both the programs to monitor your localized UPS or 
run the programs on two different computers. 

1. Multi-Computer Shutdown. 

UPSentry Service with 2 modes: Master and Slave.  

If there is a communication cable between the computer and a UPS, this computer 
called Master. The Master can monitor and control the connected UPS directly, as it 
also transmits the UPS information to the Slave(s). 

If a computer does not connect to the UPS directly but is powered by the same UPS, 
this computer called the Slave. Master communicates to Slave via a TCP/IP network. 

When a power event occurs, Master (UPSentry Service) gets the information and then 
transmits it to the Salve(s) ( UPSentry Service). Each UPSentry Service executes 
different "Actions" (FlexEvent) such that the system manager can configure a different 
strategy to a different computer. For example: When power fails, file server and mail 
server won't shutdown until the UPS battery is low but some unimportant workstations 
execute shutdown OS after 5 minutes and the other workstations shutdown after 10 
minutes. Shutdown workstations preserve more battery power for network servers. 
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Remote Monitor And Control 
2. Remote Monitor and Control: UPSentry Monitor. 

UPSentry Monitor has the ability to monitor Local host and Remote host.  

 

You can run UPSentry Monitor without running UPSentry Service, UPSentry Monitor 
will search hosts in the LAN (Local Area Network) that runs UPSentry Service in the 
combo box. Click on the Host Selection combo box and it will provide a list of the 
searched hosts in the LAN. Select one, then UPSentry Monitor will connect to the 
selected host. The host is located on the internet, so you can also input the remote host 
IP address from the View – Remote Hosts menu to establish the connection. 
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Remote Monitor And Control (cont.) 
3. Remote Monitor and Control: Internet Browser. 
Another way to remote monitor UPSentry Service is by using the Internet Browser. 
Launch the Microsoft Internet Explorer or Netscape Communicator, type the IP address 
in the URL and press enter you will get the UPS information. You can change the 
network port number to prevent conflict with other WEB server programs. If the port 
number is not 80 you have to type URL like this: http://172.16.176.141:2000 where 
2000 is the port number you assigned. 
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UPSentry Monitor Operation 
The Main Screen has 7 areas that present information on the operating status of your 
UPS. These areas are discussed in the following sections. 

 

Host Selection: Press the combo box to select hosts that runs UPSentry Service in the 
LAN. Users can monitor or control (need password) remote UPS.  

Connection Indication: The sine wave will appear while the communication between 
UPSentry Monitor and UPSentry Service is established.  

Information Display: Press Bottom Layer Buttons to change the information that is 
displayed in this area.  

Recent Event Log: Shows the last 10 event logs in the combo box, click on the combo 
box to pull down and see the logs.  
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Top Layer Buttons 
Top Layer Buttons 
These buttons used to speed up your operation. 

Refer to the dialog boxes in the menu. 
Configuration: Same as the System-> Configuration in the menu.  
Meters: Same as the View-> Meters in the menu.  
Event Log: Same as the View-> Event Log in the menu.  
History Graph: Same as the View-> History Graph in the menu. 
 
UPSENTRY Monitor Main Menu 
The Main Screen has a menu bar at the top with 4 main options: 

System: This menu allows you to set the UPSentry and computer parameters.  
Control: This menu allows you to set UPS buzzer, outlet, and test ...  
View: The View menu allows you to see the real-time values and history event or 
history data.  
Help: The Help menu allows you to access the online help system. 
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System Menu 
The system menu allows you to configure the UPS and monitor screen parameters. 
When you select the System menu from Main Menu bar, a drop down menu appears 
offering you the following menu options: 

Login: Used for Remote Monitor. User must pass the password 
verification before he/she can control or configure the UPS.  
Configuration: The Configuration menu allows you to tailor 
various UPSentry parameters.  
Monitor Screen: Allows you to change display items in the 
Scroll screen of Information Display Area  
 
 
 

Window: This menu allows you to change the display items in the Information Display 
Area. The items in the menu refer to each button in the Bottom Layer Buttons.  
Close Monitor: Stop UPSentry Monitor. 
 
Login 
When UPSentry Monitor becomes a Remote Monitor (connect to different host) you 
have to pass the password verification if you want to do configuration or control the 
UPS, otherwise, you can only view the UPS information. 
If the user runs UPSentry Service and UPSentry Monitor in the same computer, you 
can do your configuration or control the UPS without a password. 
To change your password, please choose the Set Password from the Configure - 
Network menu 

 



 

 14

System Menu (cont.) 
Monitor Screen 
This dialog box allows you to change display item in the Scroll screen of Information 
Display Area  

a. Meters: Press the Main button 
in the Bottom Layer Buttons, 
there are two meters in the 
information area. You can 
change the display items of the 
two meters.  

b. Scroll Window: Press the 
Scroll button in the Bottom 
Layer Buttons, the scroll 
window display in the 
information area. This item 
allows you to change the 
display step and items. 

Window 
This menu allows you to change the display items in the Information Display Area. The 
items in the menu refer to each button in the Bottom Layer Buttons. 

 

Close Monitor 
Close UPSentry Monitor and leave UPSentry Service running. 
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Configuration Window 

The Configuration Screen has a menu bar at the top with three main options: 
Devices: This menu allows you to configure modem, pager and e-mail.  
UPS: The UPS menu allows you to plan the UPS schedule or do the Action...  
Network: This menu allows you to choose Master/Slave or configure SNMP, HTTP 
functions. 
 
Configuration Window 
UPS Communication Port: COM1, ... COM4.  Port names are different from systems. 
Next UPS Test Date/Time: The date of the next user-initiated UPS self test. Setting 
from System->Configuration->UPS->Schedule.  
Next UPS Shutdown Date/Time: This field display the date of the next shutdown the 
computer and UPS. Setting from System->Configuration->UPS->Schedule.  
Next UPS Restart Date/Time: The date of the next restart UPS. Setting from System-
>Configuration->UPS->Schedule.  
Local Host IP: IP address of a computer, that runs UPSentry Monitor.  
UPSentry Service Mode: UPSentry Service acts as a Master or Slave.  
Remote Host IP: The host, that runs UPSentry Service. If UPSentry Monitor and 
UPSentry Service run on the same computer this field will be empty. 
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Devices Menu 
Devices  

Modem: To let UPSentry notify you via pager, you must setup the modem device. 
UPSentry will control the modem device using AT Command as default. 

a. COM Port: The 
communication port 
COM1, ...COM4.  
b. Baud Rate: Define the data 
transmitting speed.  
c. Initialize String: The string, 
that is sent to the modem 
before paging is attempted.  
d. Dial Prefix: The string, that 
added to the beginning of each 
of the Pager Number before 
they are sent to the modem.  
 

 
 



 

 17

Notification Users: Pager List 
Notification Users -- Pager List: The program will dial the modem to notify all of the 
pager number that are listed on the pager list. You can input your pager number by 
yourself. For example if, 060123456 is your pager number, each ',' tells modem to delay 
2 seconds, the delay time is for waiting the response signal from switching then 
transmit the display number 119. 119 will appear on your pager LCD.To trigger the 
pager notification you must enable the Pager Action in the Action dialog box.  

a. Add: Add a new pager number.  

b. Modify: Modify the selected pager number.  

c. Delete: Delete the selected pager number.  



 

 18

Notification Users: E-Mail 
Notification Users -- E-Mail: You can also e-mail information to users when power 
event occurrs. The program calls the sendmail command to transmit information to the 
assigned e-mail users. 

To trigger the e-mail notification you must enable the e-mail Action in the Action dialog 
box.  

a. Add: Add a new user.  
b. Modify: Modify the selected 
user name.  
c. Delete: Delete the selected 
user. 
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Notification Users: Network Broadcast 
 Notification Users -- Network Broadcast: You can also broadcasting information to 
users when power event occurs. To trigger the broadcasting notification you must 
enable the Broadcast Action in the Action dialog box.  
 
a. Domain: Enable this item to broadcast all the users in the domain, otherwise 

UPSentry will send messages 
to the hosts that user assigned.  
b. Add: Add a new machine 
name.  
c. Modify: Modify the selected 
machine name.  
d. Delete: Delete the selected 
name.  
 
 
 
Close: Close the Configuration 
window. 
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UPS Menu 

 
UPS Property: This dialog box allows you to configure the UPS COM port, battery 
replacement date,... etc. Load Warning and Load Severity are used to prevent UPS 
overload (see the UPS hardware user's manual). Load Warning will notify the user to 
reduce the load of the UPS. Load Severity will shutdown the computer to prevent 
overload.  

 
a. COM Port: 
COM1, ...COM4.  
b. Load Warning: 
Load warning.  
c. Load Severity: 
User must reduce 
UPS loading.  
d. Last Battery 
Replacement 
Date: Record last 
battery 
replacement date.  
e. Next Battery 
Replacement 
Date: The date of 
next battery 
replacement, 
UPSentry will 

notify user to replace the battery.  
f. Host Name: Local host name.  
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UPS Menu (cont.) 
Attached Devices: Assign the attached device name. When you are controlling the 

outlet, UPSentry will let you know which devices you are controlling.  
 

a. Select an Outlet Group: Assign an outlet group. Please see the back panel 
carefully, for some outlets may share one control relay, these outlets are called 
the outlet group. If you turn off outlet group1(for example: outlet1 and outlet2) 
then the UPS will stop power output to outlet1 and outlet2.  

b. Device Name: Assign the attached device names, for example: Outlet Group1 is 
for printer, Outlet Group2 is for computer. These records can improve the 
efficiency of your management. Don't forget to press the Update button.  

c. Update: Update your change.  
 

Log Management: (Please consider about the free space in your hard disk)  
a. Maximun Event Log Entries: UPSentry  saves less than the assigned entries of 

the event log.  
b. Data Log Interval: Time to save 
a record of UPS data.  
c. Maximun Data Log Storage: It 
allows you to save how many 
months of UPS data files.  
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Schedule 
Schedule: This function allows you to shutdown, restart, test and turn on/off outlet. You 
can schedule up to 6 events. Setting is based on day, week or month and up to a 
period of 2 years.  

Choose the applicable schedule to set whether it be for:  
a. One Time: This set schedule is applicable for a single day.  
b. Daily: This set schedule is applicable for every day  
c. Weekly: This set schedule is applicable for once a week period.  
d. Monthly: This set schedule is applicable for once a month period.  
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Action 
Action: The action menu provides you with a list of events to choose from. The event 
and/or any combination of these actions can be selected from the Choose Event list 
box. Actions that are already enabled will show a check mark. To delay the actions, set 
the desired time for delay in the Delay combo box.  

 
a. Choose Event: When you select one item in the list the action buttons will 

display current setting. Press button to do further configuration.  
b. Set Default: Set all the actions to default values.  
c. Delay: The power event must stay the delay time to trigger actions.  

All the actions will be described here.  
Stop All Action: Clicking on this terminates all the actions immediately.  
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Action: Shutdown 
Action - Shutdown:  
Shutdown/Hibernate/Suspend the operating system or 
shutdown UPS. Both Hibernate/Suspend are available 
only on MS Windows. If you select shutdown item, 
UPSentry will execute or ignore the Auto-Save function 
depending on your selection (in the Action dialog box). 
But if you select the suspend or hibernate item, the 
program will ignore the Auto-Save function. The 
functions of shutdown, hibernate or suspend are the 
same as if you select the Shutdown... from Windows 
Start menu.  
 
 
 
 
 

 
Action - Logging: Permits you to log 
event as well as modify default logging 
message. You can see this message in 
the Event Log dialog box.  
 
 
 
 
 

 
Action - Broadcasting: Permits you to 
broadcast an event based on a set 
period of time. If you want to be notified 
once, set the time period to "0". However, 
if you want to be notified more than once, 
set the time period to a bigger number. 
Each number corresponds to the times of 
notification.  
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Action: Paging 
 

Action - Paging: Permits you to set the 
time period of paging intervals. If you 
want to be notified once, set the time 
period to "0". However, if you want to be 
notified more than once, set the time 
period to a bigger number. Each number 
corresponds to the times of notification.  
 
 
 
 
 
 
 
 
 
 
Action- Command: Permits you to 
execute command files and set a period 
of time to delay its activation. To enable 
or disable this action, mark the Enable 
Command check box.  
 
 
 
 
 

 
Action - Alarm: Permits you to send out audible 
alarm instead of a broadcast message. There is 
only buzzer alarm for UPSentry Smart on UNIX. If 
you want to be notified once, set the time period to 
"0". However, if you want to be notified more than 
once, set the time period to a bigger number. Each 
number corresponds to the times of notification.  
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Action: E-Mail 

Action - e-mail: Permits you to send 
mail. If you want to be notified once, set 
the time period to "0". However if you 
want to be notified more than once, set 
the time period to a bigger number. Each 
number corresponds to the times of 
notification. You can edit the user list by 
clicking the Edit list button, and add, 
modify or delete any user name in the list. 
To enable or disable this action, mark 
the Enable e-mail check box.  
 
 
 
 
 
 
 
 
 

 
Action - SNMP Trap: Lets you send a SNMP 
trap when the relative power event occurs. To 
enable or disable this action, mark the Enable 
SNMP Trap check box. You also need to specify 
the SNMP Trap target hosts and community 
string, please see the SNMP dialog box in the 
Network menu.  
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Action: Receptacle Control 

Action - Receptacle Control: Permits you to control Receptacle Relay on or off. Each 
Receptacle Relay may control not only one outlet, please see the rear panel of your 
UPS or the UPS hardware user's manual.  
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Voltage Sensitivity 
Voltage Sensitivity: Adjust the UPS voltage sensitivity.  

 
Transfer Voltage: Change the low transfer voltage and high transfer voltage. This 
function lets your UPS suit the local power environment.  
 
a. Low Transfer Voltage: When utility power voltage is lower than the assigned value, 

the UPS will switch to backup. The output power 
is supplied from battery.  
b. High Transfer Voltage: When utility power 
voltage is higher than the assigned value, the 
UPS will switch to backup. The output power is 
supplied from battery. 
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Advanced UPS Property 
If your UPS doesn't support this function, the item 
will display a grayed area and the user cannot 
select this item.  
Enable Wakeup Computer: If your computer’s 
architecture is compatible to ATX and the BIOS 
supports RS-232 (RI) Wakeup function. You 
should enable this item to make the Schedule 
work correctly.  
Enable Resume Computer: Be sure the BIOS 
supports RS-232 (RI) Wakeup function. When 
UPSentry suspends the computer and the UPS 
detects the change of power status, UPS will 
resume the computer and let UPSentry notify the 
users.  
Enable Power Fail, Auto-Reboot: The time-line 

describes below,  
If you enable this function, the UPS will reboot to restart the computer. Otherwise, it will 
return back to normal state.  
Enable Economic Mode: Switch to UPS economic mode.  
UPS Periodic Auto-Test: Daily, weekly, biweekly and monthly. UPS starts the test 
procedure automatically when it reaches the test time. 
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Network Menu 
Network : 

Set Password:  
Set the UPSentry Service password.  
 
 
 
 
 
 
 
 
 
 
 

 
Choose Master/Slave:  
Set UPSentry Service mode. If the computer is connected to the UPS directly (with RS-
232 cable or USB cable) then the UPSentry Service acts as a Master, otherwise it is a 
Slave. When UPSentry Service is a Slave you must assign the Master IP address such 
that the Slave can connect to the Master host and get the UPS information.  
 

a. Master: Configure the UPSentry Service to be a Master. The Master will forward 
the UPS information to a connected Slave(s).  

b. Slave: Configure the UPSentry Service be a Slave.  
c. Master IP Address: When UPSentry Service becomes a Slave you must assign 

the Master IP address such that the Slave can connect to the Master host and 
get the UPS information. If you leave the item empty or type a wrong address, 
UPSentry will show a disconnect message. 
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Remote Wakeup 
Remote Wakeup:  
To wake up the remote host, UPSentry sends a Magic Packet through the network. You 
must give the IP address and the network hardware address (MAC address) of the 
remote host. In Windows98, you can execute the "ipconfig /All" command under MS-
DOS prompt to get the network card physical address of the local host. Or, input the 
"arp -a" command to see the remote host’s physical address. Your network card must 
support the remote wakeup feature and this function should be enabled.  

a. UPSentry Resume The 
Computer From Suspend Mode: 
UPSentry may force the computer 
into suspend mode (input power 
failed or other power events), 
program will wake up the remote 
hosts that enable this item when 
the local host is woken.  
b. Each Time UPSentry Startup: 
Program will wake up the remote 
hosts that enable this item when 
UPSentry starts up and connects to 
the UPS.  
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SNMP 
Select the Accept SNMP 
packet from any hosts, 
UPSentry will accept all the 
request commands and set 
commands. When you select 
the Accept SNMP packet 
from the following hosts, 
UPSentry receives only the 
hosts that you assigned. 
Once the power event 
occurs and the user enables 
the SNMP Trap in the Action 
dialog box, UPSentry will 
send the SNMP trap to the 
hosts that are listed in the 
Trap Target list box. To add, 
modify or delete the host, 
click on its respective 
command button.  
 
If the UPSentry Service 
you are connecting is 
running on UNIX series, 
and Windows 95/98 
operating system, you can 

configure the SNMP parameters directly from the UPSentry Smart 2000:  
Select the Accept SNMP packet from any hosts, UPSentry Smart 2000 will accept all 
the request commands and set commands. When you select the Accept SNMP packet 
from the following hosts, UPSentry Smart 2000 receives only the hosts that you 
assigned. Once the power event occurred and user enables the SNMP Trap in the 
Action dialog box, UPSentry Smart 2000 will send the SNMP trap to the hosts that 
listed in the Trap Target list box. To add, modify or delete the host, click on its 
respective command button  
If the UPSentry Service you are connecting is running on Windows NT or 
Windows 2000 operating system, you must install the SNMP Service and 
configure the SNMP parameters from your operating system:  
UPSentry Smart 2000 will ignore the values that were set in the SNMP dialog box. To 
change the parameters of SNMP function, you should install the SNMP Service in the 
Network option. Select the SNMP Service from the Network option in the Control Panel 
and click the Property button to do your changes. 
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SNMP (cont.) 
If the UPSentry Service you are connecting is running on Novell NetWare 
operating system, all setting in this SNMP configuring dialog will not 
take any effect. Please edit the file SYS:\etc\Traptarg.cfg directly. 
 
SNMP Trap Number: 

Variable Trap No. Description 
dupsCommunicationLost 1 SEVER: Communication with the UPS failed 
dupsCommunicationEstablished 2 INFORMATION: Communication 

with the UPS reestablished 
dupsPowerFail 3 WARNING: Power failed! 

The UPS is operating on battery power 
dupsPowerRestored 4 INFORMATION: Power restored! 

The utility power restored 
dupsLowBattery 5 SEVER: The UPS batteries are low 

and will soon be exhausted 
dupsReturnFromLowBattery 6 INFORMATION: The UPS has returned 

from a low battery condition 
dupsLoadWarning 7 INFORMATION: Loading percent 

of the UPS over the Load Warning value 
dupsNoLongerLoadWarning 8 INFORMATION: Returnd from 

Load Warning condition 
dupsLoadSeverity 9 Warning: Loading percent of the UPS 

over the Load Severity value 
dupsNoLongerLoadSeverity   10 INFORMATION: Returned from Load 

Severity condition 
dupsLoadOnBypass 11 WARNING: The UPS loads on bypass 
dupsNoLongerLoadOnBypass 12 INFORMATION: The UPS is not on bypass 

mod 
dupsUPSFault 13 SEVER: A general fault caused in the UPS 
dupsBatteryGroundFault 14 SEVER: The UPS battery ground fault 
dupsNoLongerBatteryFault 15 INFORMATION: The UPS recovered from 

battery ground fault 
dupsTestInProgress 16 INFORMATION: The UPS test in progress 
dupsBatteryTestFail 17 SEVER: The UPS test in progress 
dupsFuseFailure 18 SEVER: The UPS fuse failed 
dupsFuseRecovered 19 INFORMATION: The UPS fuse recovered 
dupsOutputOverload 20 SEVER: The UPS overload 
dupsNoLongerOverload 21 INFORMATION: Recovered from UPS 

overload 
dupsOutputOverCurrent 22 SEVER: The UPS output over current 
dupsNoLongerOutputOverCurrent 23 INFORMATION: Recovered from UPS over 

current 
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SNMP (cont.) 
 

Variable Trap No. Description 
dupsInverterAbnormal 24 SEVER: The UPS inverter abnormal 
dupsInverterRecovered 25 SEVER: Recovered from UPS inverter 

abnormal 
dupsRectifierAbnormal 26 SEVER: The UPS rectifier abnormal 
dupsRectifierRecovered  27 INFORMATION: The UPS recovered from 

rectifier abnormal 
dupsReserveAbnormal 28 SEVER: The UPS rectifier abnormal 
dupsReserveRecovered 29 INFORMATION: The UPS rectifier abnormal 
dupsLoadOnReserve 30 INFORMATION: The UPS load on reserve 
dupsNoLongerLoadOnReserve 31 INFORMATION: The UPS no longer load on 

reserve 
dupsEnvOverTemperature 32 WARNING: The environment over 

temperature 
DupsNoLongerEnvOverTemperature 33 INFORMATION: The environment recovered 

from over temperatur 
DupsEnvOverHumidity 34 WARNING: The environment over humidit 
DupsNoLongerEnvOverHumidity 35 INFORMATION: The environment recovered 

from over humidity 
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HTTP 
UPSentry supports WEB Server for remote manager to get UPS information. User can 
use IE or the Communicator to connect to UPSentry Service. Even if your computer 
doesn't install UPSentry, you can monitor and control your UPS via the network.  

 
a. HTTP Root: The HTTP root path.  

All the html and gif files will be located here.  
b. Port Number: Default port number is 80 but if there is already one WEB server 

running you can change UPSentry Service HTTP port number to a different 
number. At the Internet Browser you can input http://172.16.176.141:2000 in the 
URL where 2000 is the assigned port number. 
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Control Menu 
Control 

Shutdown Now: This command will execute the shutdown procedure at once.  
a. Restart: This function lets you restart the OS and UPS automatically after being 

shutdown. To start the OS and UPS for the next 
schedule, mark the Restart check box.  
b. Shutdown OS and UPS: Use this function to 
shutdown both OS and UPS.  
c. SHUTDOWN OS Only: Use this function to 
shutdown OS only.  
d. SUSPEND OS Only: Use this function to suspend 
your operating system.  
e. HIBERNATE OS Only: Use this function to hibernate 
your operating system.  
 

Cancel Shutdown: This menu enables you to terminate the current shutdown 
procedure.  
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Control (cont.) 
Turn Receptacle Relay On: Turn the selected receptacle relay on. 
Each Receptacle Relay may not control only one outlet, please see the rear panel of 
your UPS or the UPS hardware user's manual.  

a. Select a Receptacle Relay: Select a 
receptacle relay.  
b. Delay: Set the delay time to turn on the 
receptacle relay.  
c. Turn On: Execute the turn on command.  
 
 
 
 
 
 
 
 

Turn Receptacle Relay Off: Turn the 
receptacle relay off. Each Receptacle Relay 
may control not only one outlet, please see 
the rear panel of your UPS or the UPS 
hardware user's manual.  

a. Select a Receptacle Relay: Select a receptacle relay.  
b. Delay: Set the delay time to turn off the outlet group.  
c. Turn Off: Execute the turn off command.  

 
UPS Audible Alarm On: Enable the UPS buzzer from the Bottom Layer Buttons. Press 
the Status button to get the UPS buzzer status.  
 
UPS Audible Alarm Off: Mute UPS buzzer alarm.  
 
10 Seconds Test: UPS switches to backup mode and output power is supplied by 
battery in 10 seconds.  
 
Deep Battery Test: UPS switches to backup mode and output power is supplied by 
battery until battery low.  
 
Cancel Test: This menu allows you to stop testing the UPS immediately. 
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View Menu 

 

Meters: The UPSentry supports up to 12 meters to be display in real-time values. Each 
meter has the ability to display all of the UPS values. Selecting different items from the 
Selection dialog box will display the selected item value.  

a. 2,4,6,8,12: Displayed meter number.  
b. Selection: Assign each meter to different UPS item value.  
c. Close: Close the meter window.  
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Event Log 
Event Log: This menu offers you the possibility of viewing past events.  

a. Exit: Close event log dialog box.  
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History Graph 
History Graph: Clicking on the History Graph opens a dialog box that contains 
information about UPS data in graph form. This information is available only if there is 
an accumulation of data. You can select the month and year you want to view.  

a. Horizontal Scale: Select the time scale.  
b. Vertical Scale: Select the value scale.  
c. Select Month: The UPS data in the month you want to see.  
d. Draw Item1(Blue): Draw the UPS item value by blue line.  
e. Draw Item2(Red): Draw the UPS item value by red line.  
f. Update: Update the graph.  
g. Exit: Close the history graph dialog box.  
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History Data 
History Data: Clicking on the History Data opens a dialog box that contains information 
about UPS data in list form. This information is available only if there is an 
accumulation of data. You can select the month and year you want to view.  

a. Select Month: The UPS data in the month, that you want to see.  
b. Update: Update the list.  
c. Exit: Close the history data dialog box.  
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Remote Hosts 
Remote Hosts: Detect the hosts which running the UPSentry Service in the LAN. You 
can also type in the IP address and connect to the WAN.  

a. Search Result: The hosts will be listed in the Search Result list box. Select the 
host you want to connect and press the Connect button to establish the connection.  

b. Connect to this IP address: UPSentry will connect to the IP address, that you 
type in.  

c. Connect: Establish the network connection. 
 

Content: This online help.  
 
About: UPSentry version and copyright. 
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Bottom Layer Buttons 
Bottom Layer Buttons 

Each button shows the respective information in the Information Area. 
Main: General Information about the UPS.  
Tree: There are 2 subtrees in the UPSentry tree: System and UPS. System tree for 
host information and the status of Master/Slave connection, the UPS tree for all of 
the UPS information.  
Time: Display the time of the schedule, battery replacement date and countdown 
time.  
Status: UPS status.  
Diagram: Indicate the UPS current flow.  
Scroll: UPS data graph.  
Outlet: Display outlet status. (If your UPS cannot control outlet then this button 
disappears)  
Network: Indicate the connection of Master/Slave, UPSentry Monitor and UPSentry 
Service. 
 

Main  
UPS Health: 3 levels: Green, yellow and red.  
UPS Type: On line, off line, line interactive or 3 phase on line.  
UPS Model: The UPS model, which is being monitored by UPSentry.  
Firmware Version: Indicating the version status of the UPS internal code.  
Host Name: The host, which runs UPSentry.  
Rating VA: The UPS rating VA.  
Rating Input Voltage: The UPS rating input voltage.  
Rating Current: The UPS rating current.  
Rating Battery Voltage: The UPS rating battery voltage.  
Rating Input Frequency: The UPS rating input frequency.  
Test Result: Results of the last self-test.  
AC Source: Normal, battery or bypass.  
Battery Status: The status of battery.  
Battery Level: Percentage of battery level.  
Loading: Output loading percentage.  
UPSentry with the ability to change the display item of the meters, the referred 
menu item: System-> Main Screen. 
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Time  
Last Battery Replacement Date: To change the date of last battery replacement in 
the System-> Configuration UPS->UPS Property.  
Next Battery Replacement Date: To change the date of next battery replacement 
in the System-> Configuration UPS->UPS Property.  
Next 10 seconds Test Time: System-> Configuration UPS-> Schedule.  
Next Deep Test Time: System-> Configuration UPS-> Schedule.  
Next Shutdown UPS Time: system->Configuration UPS-> Schedule.  
Next Restart UPS Time: System-> Configuration UPS-> Schedule. 
 

Status  
Show all of the UPS status, red light indicates this event happened. 
 

Diagram 
Input and output power flow of UPS. 
 

Scroll 
Record the recent UPS data information. you can change the display item from 
System->Main Screen. 
 

Network 
Display all the UPSentry Service searched in the LAN. 
 

Outlet 
Display the UPS outlet status (If your UPS cannot control outlet this button 
disappeared). 
Status: Identify the current outlet status: Normal or shut.  
Next Turn Off Time: System->Configuration->UPS->Schedule  
Next Turn On Time: System->Configuration->UPS->Schedule 
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